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1. [bookmark: _TOC_250050]General Information
1.1. [bookmark: _TOC_250049]Indications for Use
SensiCardiac is an electronic auscultation device, intended to provide support to the physician in the evaluation of heart sounds in patients.
The product will acquire and record the acoustic signals of the heart and analyse these signals. The analysis procedure will identify specific heart sounds that may be present. Identified sounds include S1, S2, and suspected murmurs.
The device is indicated for use in a clinical setting, by a physician or trained personnel who are acting on the orders of a licensed physician. It is not intended for use as the sole means of diagnosis.
The interpretations of heart sounds offered by the SensiCardiac are only significant when used in conjunction with physician over-read, as well as consideration of all other relevant patient data.
NOTE
· The device is not intended to be the sole means of diagnosis.
· Final judgment on the diagnosis still lies with the qualified medical personnel.
· The medical history and physical examination results must be taken into consideration during the decision-making process.
· The software is intended for use in a quiet environment on patients with an audible heart sound.
1.2. [bookmark: _TOC_250048]SensiCardiac Models
Two models of SensiCardiac are available, depending on the stethoscope used.
SensiCardiac with Littmann 3200
This model of the SensiCardiac software is optimised to work with the Littmann 3200 electronic stethoscope. Consult the user manual of this stethoscope for optimal performance.
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1.3. [bookmark: _TOC_250047]Contra-Indications for Use
SensiCardiac is not a diagnostic tool but an aid for the physician in making a diagnosis while taking into account the whole medical history of the patient.
SensiCardiac is not to be used in a noisy environment. Care should be taken that no external noise could influence the sound recording of the electronic stethoscope.
SensiCardiac should not be used on patients where the physician has difficulty to auscultate with an electronic stethoscope, obese patients and patients with pulmonary noise.


SNSS2-50-UMAN-003
Page 6 of 45

1.4. [bookmark: _TOC_250046]Precautions & Warnings

[bookmark: _TOC_250045][image: ]SensiCardiac General Warnings
A warning statement in this manual identifies a condition or practice, which if not corrected or discontinued immediately, could lead to patient injury, illness or death. These warnings pertain only to the SensiCardiac software.
WARNING: The information in this manual is a comprehensive guide to the operation of SensiCardiac. For best results, read this manual thoroughly before using the device.
WARNING: SensiCardiac is designed for medical clinician use. Only a trained clinician who knows how to auscultate should use this device.
WARNING: SensiCardiac is not intended for use in environments that are not under the supervision of a health care practitioner..
WARNING: SensiCardiac is not intended for continuous monitoring and must not be used as such. Where continuous monitoring is required, the appropriate equipment must be used.
WARNING: To ensure patient safety, use only accessories and supplies recommended for or supplied with SensiCardiac.
WARNING: Do not use the SensiCardiac during magnetic resonance imaging (MRI) scanning.
WARNING: Carefully route patient cabling to reduce the possibility of patient entanglement or strangulation.
WARNING: This device captures and presents data reflecting a patient’s physiological condition. When reviewed by a trained physician or clinician, this data can be useful in determining a diagnosis. However, the data should not be used as the sole means for determining a patient’s diagnosis or prescribing treatment.

[bookmark: _TOC_250044][image: ]SensiCardiac Precautions
A caution statement in this manual identifies a condition or practice, which if not corrected or discontinued immediately, could lead to equipment failure, equipment damage or data loss.
These cautions pertain only to the SensiCardiac software.
Caution: If the accuracy of any measurement is in question, check the patient’s vital sign(s) with an alternative method and then check to verify if the device is functioning properly.
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Caution: For proper patient electrical isolation, only use a computer isolated from the supply mains.
Caution: Use only parts and accessories that are supplied with the device and available through a legal supplier. The use of accessories other than those specified may result in degraded performance or unsafe use of the software.
Caution: Portable and mobile radio frequency (RF) communications equipment can affect the performance of the Bluetooth interface.
[bookmark: _TOC_250043]System Requirements
To run both models of SensiCardiac your computer system must meet the following requirements:
· Windows 7 or 8 (32/64 bit)
· Minimum RAM: 2 GB
· Core2Duo processor
· 1024 x 768 graphics display or better
· 40 Mb open hard drive space
· Audio Interface:
· 16-bit audio sound card interface (external USB sound card recommended) for the SensiCardiac with ThinkLabs Model.
· Internal	or	external	Bluetooth	connection	for	the
SensiCardiac with Littmann 3200 model.
Required Accessories SensiCardiac with Littmann 3200:
· Littmann 3200 electronic stethoscope
For audibility of the heart sounds, use headphones of good quality with a frequency range from 20 Hz to at least 10 kHz or higher.
NOTE: Using the SensiCardiac with Littmann, playback is only possible through the Bluetooth stethoscope.
[bookmark: _TOC_250042]Privacy Statement
The software is used to store personal clinical and medical information. The use, storage and disclosure of information submitted, created or stored for the application of this software, either electronically or otherwise, is subject to all international, national, state/provincial and local laws, practices and regulations that are applicable to you, in particular laws, practices and regulations relating to privacy, and data, including the
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use, storage, disclosure and transmission of individually identifiable information.
You are responsible for familiarizing yourself with any such laws, practices and regulations and for making the necessary arrangements to implement appropriate security measures to control access to patient data submitted, created and stored in relation to the software.
In view of the above, the software permits the disclosure or sharing of heart sound recordings without disclosing the patient’s identity and no personal information is embedded within the heart sound files.
Accordingly, you hereby assume all risks, responsibilities and liabilities associated with the use, storage, disclosure and/or transmission of information in relation to the software and Diacoustic is hereby indemnified from any claims, losses or damages resulting from your actions or negligence in this regard.
Please consult your institution's information technology (IT) department or computer technician to implement appropriate security measures to protect access to patient data created and stored using this software.
[bookmark: _TOC_250041]Licensing Agreement
Installing this software on your computer for the first time allows you to use it for a 15-day evaluation period and makes you subject to our End User License Agreement. After payment for the software and registration on the website of SensiCardiac (www.sensicardiac.com) you will receive a unique activation code.
This code is linked to the serial number and registration code of the software.
You will be allowed to register the software on no more than three computers. For each computer you will have to apply for a new unique activation code.
Diacoustic Medical Devices will not take responsibility for the misuse of this software package.
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2. [bookmark: _TOC_250040]Getting Started
2.1. [bookmark: _TOC_250039]Watch the Video
[image: ]Access the video on YouTube or scan the Quick Response (QR) code to watch on your mobile device.






2.2. [bookmark: _TOC_250038]Installing SensiCardiac
Download	the	appropriate	SensiCardiac	software	from www.sensicardiac.com and run the installation executable file.
· SensiCardiac with Littmann 3200.
If you do not agree with the licensing agreements, select the "I disagree option", exit the installation process.
The following software programs are installed during the installation process if it was not previously installed on your computer.
· Windows Installer 3.1
· .NET 4.0 Client Profile
· SQL Compact Edition SP2
After installing these programs, your computer will be restarted and proceed with the installation process. In the event that the installation process does not proceed automatically, re-run the downloaded installation executable file.
2.3. [bookmark: _TOC_250037]Stethoscope Set-up
SensiCardiac with Littmann 3200
See the Littmann 3200 stethoscope user manual before using this stethoscope.
For a reliable Bluetooth connection the Littmann 3200 and computer must not be separated by more than 1 meter (3 feet).
2.4. [bookmark: _TOC_250036]Register your SensiCardiac Software
For registration you can select the Register Online link on the registration form, at start-up. This will take you to the SensiCardiac website where you
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must register as a user. After registration you will receive a notification email and your user account will be activated.
On the registration page you can select anyone of our three plans (Free trial, PRO package, or the Business package). The Business package is custom priced, and an account manager will assist with the technical roll- out of the product. The Free Trial and Pro Packages will allow you to use SensiCardiac for the duration of the subscription purchased.


[image: ]
Figure 1: SensiCardiac product registration window
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3. [bookmark: _TOC_250035]Use Instructions
3.1. [bookmark: _TOC_250034]Icons, Buttons and Controls

	Record & Re-record Button

This button is selected to begin a recording at a selected location. It can only be activated after all the patient’s information has been completed and you have selected Continue. The Step 1: Record at Aortic window appears with the Record button. Apply all the recommendations stipulated and then select Record. The Record button in the wizard is not active when the Start Auscultation icon is selected.

This button is selected to re-record at a selected location. Select the location on the image or within the patient explorer then select the Re- record button. For all new recordings, the Auscultation sequence wizard should be followed.

	Play Button
When this button is selected the complete audio recording of the selected heart sound is played back.
NOTE: Using the SensiCardiac with Littmann, playback is only possible through the Bluetooth stethoscope.

	
Stop Button
This button stops the recording or audio playback. It is only visible while playing back a
signal or recording a new signal.
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	More Button

Provides more information on the patient that you have selected. When this button is selected the patient information window opens.Select the double arrows below “birth date” to retrieve more information. The result of the echocardiogram, weight and physician comments are of the information that you can retrieve.

	
Volume Control

The volume of the heart sound can be controlled by means of the slide control. Minimum volume intensity is at the left and maximum volume on the right.

If the volume is muted a red cross is indicated. Clicking on the red cross unmutes the audio for the selected device.

	
Playback Speed Control
Sets the speed at which the selected heart sound can be listened to. Full speed is the speed at which the original recording of the heart was done. At half speed the heart sound is slowed down to half the speed of the original recording.
This function is not supported on the Littmann 3200.

	
Amplification of Heart S1/S2 & Murmur

Enables the amplification of different components of the heart sound. S1 and S2 sounds are made more audible by amplifying the lower frequency band in which the S1 and S2
sound components are found by ignoring the
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	higher frequency bands. Similarly, murmur
amplification increases the audibility of the higher frequency sounds where the murmurs are more audible and suppresses the S1 and S2 sound components.

A tick will appear in the block of the component, should you wish to amplify.

	
Export Data

Store selected recording, dataset or patient data to hard disk for email or backup.

File type options include, *.wav, *.sen, *.zip.

Wav files are stored without patient information for use with audio players.

Sen files can be imported in other Sensi apps, and stores recording information.

Zip files store patient information along with a patient recorded dataset.

	
Import Data

Patient data, or signals that were recorded using SensiCardiac can be imported. Supported files from export are *.sen, *.zip files. Recordings are imported to the selected patient.

	Delete Data

To remove the current selected patient, recording dataset or signal. Data is permanently removed.

	Deselect Items

Operations such as export, import and delete
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	operate on selected items. To unselect an item
the user may click on an open area or the deselect button.

	


Figure 2: The audio control panel



The audio toolbar contains all the recording controls for an auscultation test as described above.
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3.2. [bookmark: _TOC_250033]The Auscultation Sequence Wizard
The wizard bar contains all the steps to complete an auscultation sequence. The steps have to be done in sequence to be completed successfully.
To start an auscultation sequence, select the Start tab. This could also be used to perform a new auscultation sequence for an existing patient.



Figure 3: The auscultation quick links

[bookmark: _TOC_250032]Starting a Recording Sequence
1. Start new auscultation
2. Complete patient information and select Continue
3. Step 1: Record at Aortic appears. Read four points for accurate auscultation results in the dialogue window.
· Select the recording duration (10-20 seconds).
· When you and the patient are ready, select the Record[image: ] button. The recording begins and the waveform for the selected location can be seen in real-time.
· The Cancel icon cancels the recording process.
· Verify the calculated heart rate. If the displayed heart rate corresponds with the patient’s heart rate, accept the recording, or else select the appropriate heart rate and verify the re- calculated heart rate. If the software is not able to calculate the correct hart rate, or if you are not satisfied with the recording quality, select Re-record.
4. Select Step 2: Record Pulmonary. Follow the same standard procedure as for Step 1 and select the Record button.
5. Select Step 3: Record Tricuspid. Follow the same standard procedure as the previous step and select the Record button.
6. Select Step 4: Record Mitral. Follow the same standard procedure as the previous steps and select the Record button.
7. Select Finish: Show Results. The Patient Findings screen appears with the name of the patient and an analysis, confidence and heart- rate recordings. Below these recordings the analysed locations and the posture position in which they were recorded are indicated.
8. This information may be saved in a PDF format when the PDF button is selected. When the Finish button is selected it is possible to analyse different heartbeats when a certain heartbeat is selected on the heart sound graph.
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9. In the right-hand panel the four recordings of the patient can be selected. Select the patient and the date of the recording will be displayed. Click on the square with a plus sign, next to the date, and the different location recordings are displayed.
10. If more information on a patient is required select the More [image: ]
button.
11. When information of a new patient has to be created return to Step 1.
[bookmark: _TOC_250031]Interrupting the Recording Sequence
During the recording you may click on the Stop [image: ]button to terminate the recording. A dialogue window will appear which informs you of an error. When you have closed the window you may begin with a new recording by selecting the Record [image: ]button.
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3.3. [bookmark: _TOC_250030]Panels and Forms
[bookmark: _TOC_250029]SensiCardiac Splash Window
Figure 4: The SensiCardiac splash window

This panel appears when you start the SensiCardiac software and will indicate which model of the software is started.
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[bookmark: _TOC_250028]Bluetooth Pairing and Connection Windows for SensiCardiac with Littmann 3200


Figure 5: The Littmann 3200 set-up window

The computer’s internal Bluetooth device or the external USB Bluetooth device shipped with the stethoscope could be used. For optimal connection results, the external Bluetooth device is recommended.
These windows are only relevant for the SensiCardiac with Littmann 3200
software.
After start-up, the Littmann 3200 Set-up screen will appear.
If you have a new stethoscope and have not paired your computer with  this stethoscope before, select the Pair button and follow the instructions displayed.
· Press and release the M button on the stethoscope.
· The stethoscope’s main menu will display.
· Use the (-) button to scroll to the Pair option.
· Select this option by pressing (M).
· The LCD will display the paring status.
· Select the Pair button as displayed in the figure below to proceed.
· Enter the required Pin number within the Windows environment.
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Select Pair on the Littmann 3200 set- up window

Scroll to Pair on the stethoscope Menu and select

Enter the pairing code in the software window and proceed




Figure 6: The Bluetooth pairing window

If the devices were paired before, select the stethoscope you want to connect to and press the Connect button:
· Depress and release the (M) button.
· Scroll with the (-) button to the Connect option.
· Select Connect by pressing (M).
· Select Connect within the window below.
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Figure 7: The Bluetooth connecting window

[bookmark: _TOC_250027]Health Professional Information
Figure 8: Health professional information

This panel is completed by the health professional that performs the
SensiCardiac test on the patient.
Create new: Creates a new operator/health professional on the system.
Remove user: Removes the current selected operator/health professional from the database containing all the patients created by this operator/health professional.
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Continue: After selecting an operator/health professional, select continue to proceed with using the program.
Cancel:	Cancels	this	process	of	creating	a	new	operator/health professional.
Accept: Accepts the newly created operator/health professional and  stores the information.
Audio Connection for SensiCardiac with ThinkLabs


Figure 9: The audio device connection set-up

This window is only valid for SensiCardiac with ThinkLabs.
Verify that the stethoscope is properly connected to your computer and that the correct input device is selected. Test the selected device to be certain it is correctly connected.
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[bookmark: _TOC_250026]Expanded Patient Information
Figure 10: The extended patient information window

All the information about the patient is entered on this panel. Recommended fields to be entered:
· Patient’s current weight
· Patient’s contact details and gender
· General information about the patient and investigation
Select the Save button to store the patient information into the database.
Cancel will close the current window and will not update the database.
Discard patient will delete the current patient, with all its information, from the database.
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[bookmark: _TOC_250025]Recording Instructions
Figure 11: The recordings instructions form

There are four steps in the auscultation sequence. This window appears for each step. Follow these instructions meticulously to ensure optimal recording.
Select the current approximate patient heart rate. This can be changed at completion of the recording. Changing the heart-rate range affects the detection of the S1-S2 regions and also the diagnosis if incorrect.
The recording duration or time can be selected by means of the sliding bar. The default value is 15 seconds. The longer the recording, the better the chances for accurate results. Maximum recording time: 20 seconds.
Cancel will exit the current operations.
Import will open a navigation window from where a previously recorded heart sound could be selected.
NOTE: The recording instructions must be followed for optimal results:
· Calm the patient until relaxed and breathing easily.
· Do not speak while recording.
· A quiet environment is preferable.
· The stethoscope should be positioned against bare skin and held very still while recording.
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[bookmark: _TOC_250024]Setting the Heart Rate
Figure 12: Heart rate approval window

After each heart sound recording you will be prompted to verify the calculated heart rate. If the displayed heart rate does not correspond with the patient’s heart rate, select the appropriate heart rate range from the drop down menu or select Accept. In the case that the heart rate remains incorrect or the program is not able to re-calculate the heart rate (0 bpm), Re-record the heart sound. Re-record is also recommended if you are not satisfied with the recording quality.


Figure 13: Heart-rate interval selection table
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[bookmark: _TOC_250023]Recording Location & Results
Figure 14: The torso indicating the recording locations

This illustration indicates the different locations where recordings are done during the auscultation sequence.
When an auscultation is done the diagnosis will also be displayed.
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[bookmark: _TOC_250022]Patient Findings
Figure 15: Patient findings and results page

Patient findings are the result and summary of the auscultation sequence of a specific patient. The analysis is either ‘Class I’ or ‘Class III’. If it is Class I, the patient has to be referred to a specialist. For Class I cases with only one abnormal recording, re-record the specific abnormal location again. If it is persistently abnormal, refer the patient to a specialist.
The analysed locations are displayed in either green or orange. If they appear in green, it is regarded as Class III. However, if there are locations displayed in orange, these would be considered Class I and the patient would have to be referred to a specialist.
The indicated heart rate is the average heart rate of all four recordings.
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[bookmark: _TOC_250021]Reduced Patient Information
Figure 16: The reduced patient information

This panel indicates the minimum information about the patient. It displays two buttons, namely New Patient and More. When the New Patient [image: ]button is selected, a new patient’s information is entered. The More [image: ] button when selected, provides more information about the current patient selected.






















Figure 17: The graphical user interface with a recorded heart sound
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[bookmark: _TOC_250020]Searching for a Previously Recorded Heart Sound
Figure 18: Searching for a previously recorded patient

Select the Search icon in the frame below the patient information. You can do a search for a patient by ID, name or date. Select the patient and all the recordings that were done (Tricuspid, Aortic, Pulmonary and Mitral) appear. Click on the recording of your choice.
[bookmark: _TOC_250019]Re-record a Specific Auscultation Location
Figure 19: Re-record a heart sound at a specific location

Load the patient's recordings by selecting the specific date and time of the previous recordings. Select the recording location where the heart sound must be re-recorded and the patient’s current heart rate, select Record button as illustrated in the figure above. In the above figure the Mitral (apex) recording will be re-recorded.
Repeat Auscultation Sequence for an Existing Patient
Select the patient's name on the patient list for whom you want to repeat the auscultation sequence. Select the Record button on the audio control
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panel. The patient information sheet will appear. If required, you may edit this information or directly select Continue. Start the recording sequence at the Tricuspid area.
[bookmark: _TOC_250018]Signal Quality
While recording, the signal is displayed in real-time. If there is excessive noise, the signal display will be shown in red segments where these areas are detected.
When the signal quality is unacceptable, an error window will appear that will inform you what might be influencing the signal quality. Select Close and repeat the recording by following the standard recording procedure.
Recording quality signals for diagnostic purposes requires practice in using a digital stethoscope.
1. Proper handling of stethoscope to minimize external background noises and hand rub/clicks should be practiced.
2. Stethoscope functions, such as amplification and other filters, should be switched off for minimum signal distortion.
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4. [bookmark: _TOC_250017]Viewing and Interpreting Results
4.1. [bookmark: _TOC_250016]Auscultation Findings
Figure 20: Suspected pathological locations

Figure 21: The recording findings

After completion of all four steps in the recording process, the patient findings window appears. An analysis is made of the four recordings in their respective locations.
If a suspected pathology, with a red background, appears alongside the analysis, the corresponding location where the suspected pathology would be required is also indicated in red. Locations where no suspected pathology are required, are indicated in green.
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Class I murmur is detected if one or more of the recording locations are indicated in orange – echocardiograph recommended.
Class III murmur (or no) murmur is detected if all four recording locations are indicated in green – no echocardiograph recommended.
4.2. [bookmark: _TOC_250015]Heart-Rate Analysis & Relative Energy Distribution











Figure 22: The heart-rate analysis and energy distribution.

The heart rate of each recording of the auscultation sequence is shown in beats per minute (bpm). The average systole and diastole length, which excludes the S1 and S2 lengths and the R-R interval, is also displayed in milliseconds (ms).
The findings could assist the examiner in making decisions on heart-rate irregularities.
NOTE: If the S1-S2 peaks are detected incorrectly, the diagnosis cannot be relied on. Selecting the correct heart-rate range in these cases could improve the S1-S2 detection and might alter the diagnosis.
The relative energy distribution within the various segments of the heartbeat is for the frequency range between 150Hz and 500Hz are shown as a percentage of the total energy within the recorded beats.
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4.3. [bookmark: _TOC_250014]Heart Sound Recording Display
Figure 23: Recorded heart sound with a single beat selected

During recording, the heart sound is displayed in real-time. Where the signal is highlighted in red, abnormally high frequencies were detected, which may be an indicator of noise or a possible murmur. The noise could be from the nearby environment, lung or abdomen. Repeating noise in every heartbeat possibly originate from a cardiac murmur.
A certain area within the recording could be displayed by selecting the area with the cursor. Relative measurements could also be performed within the selected area.
4.4. [bookmark: _TOC_250013]Saving Results to a PDF File
After completion of the auscultation process, there is an option within the patient findings window to write the current findings to a PDF file. The file will be saved to a location of your choice.
The report generated will contain the examiner’s information, patient information and the auscultation findings at each recording location.
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5. [bookmark: _TOC_250012]Database Management
It is possible, for data base management purposes, to import patient data and recordings, back-up the patient database and recover previously backed-up data by selecting the File menu.
The Import function imports a database and appends it to the existing database on your computer.
The Back-up function exports the whole database and stores it at the location of your choice.
The Recover function imports the backed-up database and restores it to your current database.
The Clean function cleans up the current tree view and removes any dead links within your database if any files have been removed from the  SensiCardiac software.

6. [bookmark: _TOC_250011]Menus
The following menu settings are available on SensiCardiac's top left menu bar:
File | Settings | Help
6.1. [bookmark: _TOC_250010]File

	File > Database > Import
	To import a database and append it to your current database.

	File > Database > Recover
	In the event that your database becomes corrupt you can restore a previous back-up.

	File > Database > Back-up
	It is recommended that you back-up your database at regular intervals to minimise data loss in the event of file corruption. This menu setting exports your current database to a back- up file.

	File > Database > Clean
	When heart sound files are moved or deleted outside the application, the database links are lost. To remove these dead file links, run the "clean" function.

	File > Exit
	Close the program.
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6.2. [bookmark: _TOC_250009]Settings

	Settings > Change User
	This option opens the Health Professional window. Select or create a new user and select Continue or Accept. A user could also be removed from the system.

	Settings > Change Connectors
	Opens the Connector Selection window for selecting the correct audio input/output device.




6.3. [bookmark: _TOC_250008]Help

	Help > Getting Started
	A getting started manual. Opens a PDF document.

	Help > User Guide
	This User Guide could be accessed by selecting this link. Opens a PDF document.

	Help > Customer Feedback
	This link will take you directly to the SensiCardiac website where you could enter feedback.

	Help > Legal Notice
	This link displays the End User License Agreement.

	Help > Register
	This link will take you directly to the software registration page on the SensiCardiac website.

	Help > Help
	This link displays product and company related information.
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7. [bookmark: _TOC_250007]Improving Recording Quality
SensiCardiac's diagnostic performance and accuracy relies on the quality of the heart sound recording.
Before starting the auscultation recordings, make sure the acoustic heart sound is audible, with S1 and S2 clearly identifiable. If not, move the stethoscope head to a location of optimal heart- sound detection.
The patient must be quiet, calm and in a comfortable posture with minimum lung (pulmonary) and bowel sounds.
When handling the stethoscope, motion artifacts must be minimised. The stethoscope should also only touch the skin of the patient. Press the stethoscope head firmly against the chest of the patient for adequate sound transfer. Prevent contact with clothes and the cabling of the system. To minimise the rubbing noise, use lubrication gel.
The environment must be quiet and background noise limited to the minimum. Close doors to neighbouring rooms; switch off air-conditioners and fans or other possibly noisy equipment. Instruct all persons in the room to remain quiet for the duration of the recordings.
After finishing the recordings, verify that:
· the S1 and S2 signals are visible within the recorded heart beats;
· there are no large visual and auditory spikes in the recorded signal;
· the indicated heart rate corresponds to your measurement; and
· there is adequate recorded heart beats to analyse (more than 20 beats).
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8. [bookmark: _TOC_250006]Troubleshooting
8.1. [bookmark: _TOC_250005]Installation
See the "Getting Started" part of this manual for troubleshooting after installation or at start-up for the first time.
8.2. [bookmark: _TOC_250004]Sound Recordings

	Troubleshooting
	Action

	· No recording of heart sounds.
· Heart sound not recorded.
· Heart sound signal saturates maximum and minimum.
	· Open the sound properties and set the record settings for the audio device to default.

· Set the recording volume level to 100%.

· Set the recording sample rate and bit rate to 2 channels at 16bit, 44kHz(or 44100Hz).

· SensiCardiac should be restarted, since changing the driver settings halts the program.
For help changing these settings see http://support.microsoft.com/kb/935309.

	Re-installing SensiCardiac
after evaluation period expired.
	If you uninstall SensiCardiac after using it for the evaluation period and re-install SensiCardiac again, the evaluation period will remain expired.

	Not enough beats detected.
	Not enough heartbeats were recorded due to the fact that the heart rate may be slow and the recording duration to0 short. Increase the recording duration.

	Program crash while setting sound properties within Windows Vista & 7.
	Windows shows a warning that this might happen, “Device in use”. No information is lost. Restart the application to resume.

	When a recording fails or has an
	1. Check stethoscope volume setting.
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	incorrect result.
	2. Check line-In recording volume level. During recording the signal display should be visible as a heart sound with distinguishable beats.
3. Switch off all amplifications and ambient noise reduction filter, which alter the signal being recorded.
4. If the detected S1-S2 peaks are incorrect, selected the heart-rate range for the recording that best matches the patient heart rate. The diagnosis is dependent on correct S1-S2 locations.
5. Also make sure that stethoscope is held firmly but with light pressure to minimise finger friction noises.


Table 1: List of possible sound recording troubles
Notes:
· For a reliable Bluetooth connection the distance between the computer and Littmann 3200 must not be more than 1 meter (3 feet).
8.3. [bookmark: _TOC_250003]Sound Playback

	Troubleshooting
	Action

	The recorded heart sounds do not play back properly.
	- In SensiCardiac Software select ‘Settings->Devices’ from menu. Select correct output device from list of audio output devices. Make sure your headphones are plugged in and volume correct, then click the Test button to make sure the hardware is correctly set-up.
– Set the playback volume to 100%.


Table 2: List of possible sound playback troubles
NOTE: Heart sounds are best heard using an electronic stethoscope.
If you intend to use speakers or headphones make sure the frequencies response of the device supports the very low frequencies at which heart sounds are audible (between 20-500Hz).
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8.4. [bookmark: _TOC_250002]Error Messages

	Error Message
	Reason & Action

	Heart sound signal quality test failed.
	· Initial 3-second quality test failed.

· Follow the recording instructions.

· Re-record the heart sound.

	Less than 5 useful beats detected after beat filtering.
	· The heart sound signal could not be analysed correctly.

· Follow the recording instructions.

· Re-record the heart sound.

	Heart sound signal could not be analysed correctly.
	· The signal variations were too large.

· If the heart rate is fast, reduce recording time.

· Follow the recording instructions.

· Re-record the heart sound.

	Signal length incorrect.
	· Follow the recording instructions.
· Re-record the heart sound.

	Recording stopped. Please Re- record the signal.
	· Verify that all cables are connected correctly.

· Verify that the stethoscope is switched on.

· Follow the recording instructions.

· Re-record the heart sound.

	Stethoscope powered off or not connected.
	Verify that the stethoscope is switched on and try again.

	Please select a beat from the Heart Sound to repeat.
	· You have selected the Repeat button to play a single heartbeat continuously in a loop, but did not select a beat.

· Select the heart sound beat you want
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	to play within the heart sound window and press Repeat again.

	The database directory does not exist. Please try again.
	· The patient database directory does not exist within the user profile directory.

· Make sure the current windows user profile is the same as the user that installed the software.

· Restart the program and try again.

· If the error persists, uninstall the software and re-install it.

	An error occurred while attempting to clean your database. Please try again.
	· A process or program on your computer prevents access to the database file.

· Close all programs and restart the program.

	No recording is selected to export. Please select a recording and choose this option again.
	· You've selected the option to export a single recording, but did not select a recording.

· Select the recording you want to export within the patient tree view and select the export option again.

	No patient is selected. Please select a patient to export the desired records.
	· You've selected the option to export a patient’s recordings, but did not select a specific patient.

· Select the patient's data you want to export within the patient tree view and select the export option again.

	An error occurred while attempting to recover your database. Please close all Windows Explorer directories that are open and try again.
	· Close all programs, restart SensiCardiac and try again to recover your database.

· Make sure you are selecting the correct back-up files.
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	The file that you selected must have a zip file extension.
	· To import a heart sound the file must be in the correct format (a .zip file).

· The file you want to import must have been exported or backed-up by a SensiCardiac program.

	Could not load or analyse recording. Please go to File>Database>Clean to remove the dead link from the list.
	· The sound file was deleted from the programs database, but is still displayed within the patient tree.
· Select File>Database>Clean to remove the dead link from the list.

	Could not store recording.
	· The program was not able to store the current recording.
· Restart the program and redo the recording.


Table 3: List of possible error messages
8.5. [bookmark: _TOC_250001]Bluetooth Communication Error Messages

	Error Message
	Reason & Action

	No stethoscope is connected. You can review data and manage patients, but won’t be able to record or listen to sounds.
	You terminated the stethoscope connection steps without successfully connecting to a valid stethoscope.

You will be able to access previous
recorded patients’ data, but will not be able to record or playback heart sounds.

	Could not connect to sender stethoscope. Make sure the stethoscope is waiting to be connected to and restart the application.
The stethoscope is already connected. Select a different stethoscope.
	Connecting via Bluetooth to the stethoscope was not successful. Restart the SensiCardiac software and try again.

	Stethoscope battery level is low.
	Replace the stethoscope battery.
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	Could not find the computer's Bluetooth antenna. Make sure the Bluetooth antenna is plugged in and Bluetooth is enabled.
	The Bluetooth device was not detected. Make sure it is plugged into the computer.

If computer’s internal Bluetooth device is used, verify that it is switched on.

	Busy connecting, please wait...
	This may take a few seconds, please wait.

	Please select a stethoscope.
	Select one of the stethoscopes listed.

	Another stethoscope is already connected.
	Terminate or disconnect current connection before attempting new connection.



8.6. Table 4: List of possible Bluetooth communication error messages.
Warning Messages

	Warning Messages
	Reasons & Actions

	Heart sound probably not audible, check connectors.
	· The heart sound signal amplitude is detected as very soft.

· If the heart sound is not audible re- record the signal.

	Heart sound distortion: volume too loud.
	· The heart sound signal amplitude is detected as very loud.

· If the heart sound is clipped, re-record the signal.

	The software evaluation period has expired. You may continue using the software with limited functionality.
	· You did not register your software or obtained a valid product Product Key and Activation code.

· You will not be able to perform any heart sound recordings.

· Please visit www.sensicardiac.com and register as a user for more information.

	Select the recording location on the chest before
	Select a recording location on the image of the patient and continue.
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	continuing.
	

	Recording button disabled for trial period on expiry.
	· You did not register your software or obtained a valid product Product Key and Activation code.

· You will not be able to perform any heart sound recordings.

· Please visit www.sensicardiac.com and register as a user for more information.

	UserManual.pdf failed to open.
	· The UserManual pdf file has been moved or deleted.

· Search for UserManual.pdf on your PC.

· Load the UserManual from the installation disc or, if unsuccessful, back- up all your recordings and re-install the software.

	Make sure you have a back-up of your current database.
After recovery the current database will be deleted permanently.
	· By selecting the database recover option, your current database will be substituted by the backed-up database.

· The current database will be permanently removed and replaced by the backed-up one.

	To start a heart recording please set the windows recording device microphone properties to stereo 2-channel 22050Hz and try again.
	· Your audio settings are set to mono.

· Connect the Audio Device to the PC.

· Open microphone recording device properties.

· Select Advanced and set the default channels, sample rate and bit depth to 2 channel, 22050Hz, 16bi.t
For help changing these settings see http://support.microsoft.com/kb/935309.


Table 5: List of possible warning messages
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10. [bookmark: _TOC_250000]Warranty Information
Consult the End User License Agreement for warranty information.
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SensiCardiac is a decision support software package intended to assist medical examiners in cardiac assessments. The software will enable the medical examiner to make more accurate decisions on Class I and Class III cardiac murmurs by analysing the acoustic heart signals captured with an electronic stethoscope.
Increase your auscultation confidence and
· Detect suspected heart murmurs
· Record and display auscultation sounds
· Playback and review of previously recorded sounds
· Print auscultation findings for your records

















Consult the User Manual before using the software Minimum system requirements: Microsoft Windows® 7 or 8
Diacoustic Medical Devices (Pty) Ltd. Octo Place A3, Electron Rd, Techno Park, Stellenbosch, 7600, South Africa
T +27 (0)21 880 2223

www.sensicardiac .com

© Diacoustic Medical Devices (Pty) Ltd. All rights reserved. SensiCardiac and Diacoustic are trademarks of Diacoustic Medical Devices (Pty) Ltd. Windows is a registered trademark of Microsoft. Littmann is a trademark of 3M. Bluetooth is a registered trademark of Bluetooth SIG. ThinkLabs is a trademark of ThinkLabs Inc.SNSS2-50-UMAN-003	Page 45 of 45


image61.jpeg
Sensl

CARDIAC
DIAGNOSTIC HEART MURMUR
SOFTWARE

Initializing

Loanesbengiaes  (ACOUSTIC





image62.png




image63.jpeg
Sensl

CARDIAC
DIAGNOSTIC HEART MURMUR
SOFTWARE

Initializing

Loanesbengiaes  (ACOUSTIC





image64.png




image65.png
Littmann 3200 Setup

Stethoscopes
M3200 0003070000195120
M3200 0012050000873109

Pair Connect





image66.png




image67.png
Littmann 3200 Setup

Stethoscopes
M3200 0003070000195120
M3200 0012050000873109

Pair Connect





image68.png




image69.png




image70.png




image71.png




image72.png




image73.jpeg
Pairing process

On the Model 3200, depress and release the (M)
button. The MAIN menu will be displayed. Use the (-)
button to scroll down to the PAIR option. Select this
option by pressing and releasing the (M) button. The
LCD screen will signal that pairing is in progress with
the following animated display:

Y [

PIM
H$14a





image74.png




image75.jpeg
Pairing process

On the Model 3200, depress and release the (M)
button. The MAIN menu will be displayed. Use the (-)
button to scroll down to the PAIR option. Select this
option by pressing and releasing the (M) button. The
LCD screen will signal that pairing is in progress with
the following animated display:

Y [

PIM
H$14a





image76.png




image77.jpeg
How to connect

Depress and release the (M) button. Select the
CONMECT option by again pressing and releasing the
(M) button. The LCD screen will signal that the
Bluetooth link is active. Press ‘Connect’ button to setup
the communications link with your stethoscope.

EXIT
FCOMMECT

DIZCONH





image78.png




image79.jpeg
How to connect

Depress and release the (M) button. Select the
CONMECT option by again pressing and releasing the
(M) button. The LCD screen will signal that the
Bluetooth link is active. Press ‘Connect’ button to setup
the communications link with your stethoscope.

EXIT
FCOMMECT

DIZCONH





image80.png




image81.png
Health Professional

User l J'J

2>

Name * | <Initials> H <Last name>

Training = <Nurse / Doctor / Specialist / Other>

Contact number [ <Contact number>

Company name [ <Institution / Private practice> I

Address ‘ <Address>

[ Cancel J [ Remove user J [Save changes ]





image82.png




image83.png
Health Professional

User l J'J

2>

Name * | <Initials> H <Last name>

Training = <Nurse / Doctor / Specialist / Other>

Contact number [ <Contact number>

Company name [ <Institution / Private practice> I

Address ‘ <Address>

[ Cancel J [ Remove user J [Save changes ]





image84.png




image85.png
Connector Setup

Stethoscope | _Please select your stethoscr | =
Sound Input | Microphone (High Definitic | ~
Refresh Test

Sound Output|  Speakers (High Definition / | ¥
[refesn] (=]





image86.png




image87.png
Connector Setup

Stethoscope | _Please select your stethoscr | =
Sound Input | Microphone (High Definitic | ~
Refresh Test

Sound Output|  Speakers (High Definition / | ¥
[refesn] (=]





image88.png




image89.png
Patient information +new |

o <identification number>

<initials> || <last name>

Name

BNER o

¥ sowes

Weight | Kg |~
[ ©Male O Female

Contact number

Address
Patient information / physician comments

<comments>

Cancel | Discard patient Create.





image90.png




image91.png
Patient information +new |

o <identification number>

<initials> || <last name>

Name

BNER o

¥ sowes

Weight | Kg |~
[ ©Male O Female

Contact number

Address
Patient information / physician comments

<comments>

Cancel | Discard patient Create.





image92.png




image93.png
Record at Aortic (2R)

Recording Process
1. Calm patient until breathing easily.
2.Do not spezk while recording.

3. A quiet environment is preferable.

4. Stethoscope should be positioned against bare
skin 2nd held very still while recording.





image94.png




image95.png
Record at Aortic (2R)

Recording Process
1. Calm patient until breathing easily.
2.Do not spezk while recording.

3. A quiet environment is preferable.

4. Stethoscope should be positioned against bare
skin 2nd held very still while recording.





image96.png




image97.png
‘Please select ... v‘

Cancel




image98.png




image99.png
‘Please select ... v‘

Cancel




image100.png




image101.png
57 v O

Please select ... -

Default [50 - 90] bpm
Athlete [40 - 60] bpm
General [50 - 180] bpm
Specific [90 - 120] bpm
High [120 - 180] bpm





image102.png




image103.png
57 v O

Please select ... -

Default [50 - 90] bpm
Athlete [40 - 60] bpm
General [50 - 180] bpm
Specific [90 - 120] bpm
High [120 - 180] bpm





image104.png




image105.jpeg




image106.png




image107.jpeg




image108.png




image109.jpeg
Patient Findings s e n sl &

CARDIAC

Patient: Example, Normal

Analysis ClassI _ ©

Heart rate 87 bpm

Analysed locations: Monday, August 06, 2012
Aortic  Pulmonary Tricuspid Mitral
- — - —

[ Create PDF | Finish





image110.png




image111.jpeg
Patient Findings s e n sl &

CARDIAC

Patient: Example, Normal

Analysis ClassI _ ©

Heart rate 87 bpm

Analysed locations: Monday, August 06, 2012
Aortic  Pulmonary Tricuspid Mitral
- — - —

[ Create PDF | Finish





image112.png




image113.jpeg
Patient information
) 1007

Name [N | Bampie

Bithdate | coyy | mm [[dd | (>





image114.png




image115.jpeg
Patient information
) 1007

Name [N | Bampie

Bithdate | coyy | mm [[dd | (>





image116.png




image117.jpeg
eom

File Settings Help

e p— e e P Revort
Quick Auscultation [JFSPEN Resuls

Output Amplifcation Ampliication

— - & | S1&S2 | Murmur

CIEEe

a2

2 sl w2 2 2 sl sl 12

Signal Analysis Results Relative Energy for Average of Heart Beats

Heartrate:  87bpm
Avg. Systole:  249+8ms

Avg.Diastole: 203231ms || a5 | 105% Oes%  03% [|608% || oeex o1 o38x

R-RInterval:  684%36ms T T T T T i) T T
st & Ms s 52 Bl MD 1)

Export Import Delete Clear
Qv Search by First Name. x

4 Normal Example lal

| [\ 4 8/6/2012 8:55 AM
Aortic
Pulmonary

I Func Example
! Func Example2
© Func Example3
I AS Example2

I AS Example3

I ASD Example

I ASD Example2
I ASD Example3
I ASD Example4
I AVSD Example
I AVSD Example2
I FT Example

| FT Example2

I FT Example3

| MI Example

| MI Example2

I MVP Example

I MVP Example2

I MVS Example =

sensiz

CARDIAC





image118.png




image119.jpeg
eom

File Settings Help

e p— e e P Revort
Quick Auscultation [JFSPEN Resuls

Output Amplifcation Ampliication

— - & | S1&S2 | Murmur

CIEEe

a2

2 sl w2 2 2 sl sl 12

Signal Analysis Results Relative Energy for Average of Heart Beats

Heartrate:  87bpm
Avg. Systole:  249+8ms

Avg.Diastole: 203231ms || a5 | 105% Oes%  03% [|608% || oeex o1 o38x

R-RInterval:  684%36ms T T T T T i) T T
st & Ms s 52 Bl MD 1)

Export Import Delete Clear
Qv Search by First Name. x

4 Normal Example lal

| [\ 4 8/6/2012 8:55 AM
Aortic
Pulmonary

I Func Example
! Func Example2
© Func Example3
I AS Example2

I AS Example3

I ASD Example

I ASD Example2
I ASD Example3
I ASD Example4
I AVSD Example
I AVSD Example2
I FT Example

| FT Example2

I FT Example3

| MI Example

| MI Example2

I MVP Example

I MVP Example2

I MVS Example =

sensiz

CARDIAC





image120.png




image3.png




image121.jpeg




image122.png




image123.png
- MR

MR Example
4 MR Example2
4 2010/07/09 1055 AM

e

Pulmonary
Mitral
MR Example3




image124.png




image125.png
- MR

MR Example
4 MR Example2
4 2010/07/09 1055 AM

e

Pulmonary
Mitral
MR Example3




image126.png




image127.jpeg




image128.png




image4.png




image129.jpeg




image130.png




image131.jpeg




image132.png




image133.jpeg




image134.png




image135.png
Patient Findings s e n SI &

CARDIAC

Patient: Example, PDA
Analysis L Classt L ©

Echocardiography is recommended for
*— asymptomatic patients with diastolic murmurs,
~— continuous murmurs, holosystolic murmurs, late -

A systolic murmurs, murmurs associated with ejection
clicks, or murmurs that radiate to the neck or back.





image136.png




image137.png
Patient Findings s e n SI &

CARDIAC

Patient: Example, PDA
Analysis L Classt L ©

Echocardiography is recommended for
*— asymptomatic patients with diastolic murmurs,
~— continuous murmurs, holosystolic murmurs, late -

A systolic murmurs, murmurs associated with ejection
clicks, or murmurs that radiate to the neck or back.





image138.png




image139.jpeg
Signal Analysis Results

Relative Energy for Average of Heart Beats

Heartrate:  87bpm
Avg. Systole:  249+8ms
Avg. Diastole: 293+31ms

R-RInterval:  684:36ms

15%

195%

066%

033%

8082%

058%

019%

038%

T
52

MD

T
1)





image140.png




image141.jpeg
Signal Analysis Results

Relative Energy for Average of Heart Beats

Heartrate:  87bpm
Avg. Systole:  249+8ms
Avg. Diastole: 293+31ms

R-RInterval:  684:36ms

15%

195%

066%

033%

8082%

058%

019%

038%

T
52

MD

T
1)





image142.png




image143.jpeg




image144.png




image145.jpeg




image146.png
SISINSII
CARDIAC




image5.png




image6.jpeg
|_support |

Lid (240 htty iac.com

Sensliz

the confidence of knowing.

FREE TRIAL
S0

30 days
Test SensiCardiac before you buy.

Freafor 30 days.

Perform heart screenings. generate patient reports

[ER S —
Simple o upgrade to PRO package.
Free Technical Support.

Free Customer Support.

DOWNLOAD

PRO

$580
1YEAR
Fullacccess to SensiCardiac software.
Perfec for a single user.

Includes 3 free Littmann 3200 electronic
stethoscope, delivered to your door.

Unlimited instalation on multiple devices
Subseription s valid for 365 days.
Simple o upgrade to BUSINESS package.
FullTechnical Support.

Ful

ustomer Support.

BUY

FAO

BUSINESS

cusTom
1YEAR

Get a custom SensiCardiac solution for your
practice.

Customized pricing to st your needs.
Perfectfor > 1 user,
Perfectfor larger practice, linics and MSOs.
Rollout support.
Priority Techaical Support.

[ —

GET A QUOTE




image7.png




image8.jpeg




image9.png




image10.jpeg




image11.jpeg




image12.jpeg




image13.png




image14.jpeg




image15.png




image16.jpeg




image17.png




image18.jpeg




image19.png




image20.jpeg




image21.png




image22.jpeg
Volume

LK)





image23.png




image24.jpeg
Volume

LK)





image25.png




image26.jpeg
Playback speed
Holf o we— Normal




image27.png




image28.jpeg
Playback speed
Holf o we— Normal




image29.png




image30.jpeg
Amplification
SL&S2 | Murmur




image31.png




image32.jpeg
Amplification
SL&S2 | Murmur




image33.png




image34.jpeg
Export




image35.png




image36.jpeg
Export




image37.png




image38.jpeg
Import




image1.png
SISINSII
CARDIAC




image39.png




image40.jpeg
Import




image41.png




image42.jpeg
Delete




image43.png




image44.jpeg
Delete




image45.png




image46.jpeg
Clear




image47.png




image48.jpeg
Clear




image49.png




image50.jpeg
> ~ Volume Amplfication Playback speed
<.) <.) » o M viS1&S2 wMumur  Half o e Normal





image51.png




image52.jpeg
> ~ Volume Amplfication Playback speed
<.) <.) » o M viS1&S2 wMumur  Half o e Normal





image53.png




image54.jpeg
Start ot Step : Finish
(o[1TTe T Auscultation \’ S{ Show Results





image2.png
diacousTIC

MEDICAL DEVICES (PTY) LTD




image55.png




image56.jpeg
Start ot Step : Finish
(o[1TTe T Auscultation \’ S{ Show Results





image57.jpeg




image58.jpeg




image59.jpeg




image60.png




